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1 Sisäänkirjautuminen TI-tilillesi

Sisäänkirjautuminen TI-tilillesi
Jotta voisit käyttää TI-SmartView™-emulaattoriohjelmistoa MathPrint™-laskimille,
sinun on kirjauduttava TI-tilillesi.

1. Käynnistä MathPrint™-laskinten TI-SmartView™-emulaattoriohjelmisto.

Jos tämä on ohjelmiston ensimmäinen käynnistyskerta, sinua pyydetään
hyväksymään lisenssi, yksityisyyden suojamenettely sekä verkkokäyttöehdot.

Napsauta Accept.

2. Napsauta sisäänkirjautumisen pyynnössä kohtaa LAUNCH SIGN IN.

Huomaa: Jos sinun on ostettava yhden käyttäjän lisenssi, napsauta PURCHASE
LICENSE.

Tämä avaa Texas Instrumentsin kirjautumissivun selaimeesi. Suorita
sisäänkirjautuminen Google-tilillä tai TI-tiliisi liittyvällä sähköpostiosoitteella.



Kun tilisi on vahvistettu, selaimessa näkyy viesti onnistumisesta ja ohjelmisto
avautuu.

Lisensointitietojen tarkistaminen

Sisään kirjautuneena voit tarkastella lisenssisi tietoja.

▶ Siirry kohtaan Help > License Info.

Tilin tiedot: Nykyisen käyttäjän sähköpostiosoite.

Erääntyminen: Nykyisen ohjelmistolisenssin erääntymispäiväys.

Session Expiration: Nykyisen istunnon jäljellä oleva aika.

Kun ohjelmistoa käytetään, se ottaa yhteyttä lisensointijärjestelmään 15 minuutin
välein. Jos käyttäjä siirtyy jossakin vaiheessa pois verkosta, ohjelmisto käy
seitsemän päivän ajan viimeisen yhteydenoton jälkeen.

Kirjautuminen ulos tililtäsi

1. Siirry kohtaan Help > Sign out.

2. Napsauta SIGN OUT.

Ohjelmisto sulkeutuu ja selaimen välilehti avaa sisäänkirjautumissivun.

Uloskirjautuminen tallentaa vallitsevan tilan ja vapauttaa lisenssin takaisin
käytettävissä olevien paikkojen varantoon. Jos ohjelmisto suljetaan käyttämällä
kohtaa File > Exit tai sulkupainikkeella , käyttäjää ei automaattisesti kirjata ulos
eikä lisenssiä vapauteta.
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3 Johdanto – MathPrint™-laskimen TI-SmartView™-emulaattoriohjelmisto

Johdanto – MathPrint™-laskimen TI-SmartView™-
emulaattoriohjelmisto
MathPrint™-laskimen TI-SmartView™-emulaattoriohjelmiston avulla voit näyttää TI-
tieteislaskimen koko luokalle.

Laskimen emulaattorin työtila

Mahdolliset toiminnot:

• Valitse emulaattori
– Valitse käytettävä emulaattori.

– TI-30X Plus MathPrint™
– TI-30X Pro MathPrint™
– TI-30XS MultiView - TI-30XB MultiView™
– TI-34 MultiView™

• Piilota/näytä iso emulaattorin näyttö
– Näytä koko emulaattorinäkymä ison näyttöikkunan kanssa tai ilman

sitä.
• Piilota/näytä näppäilyhistoria

– Näyttää painettujen näppäinten kuvat, jolloin opiskelijat voivat
seurata näppäinten painalluksia.

• Käynnistä erillinen näyttökuvien kaappausikkuna
– Kaappaa emulaattorin näyttökuvia ja tallenna ne tietokoneen

tiedostoiksi kuten TI Connect™ CE -kuvankaappaustoiminnossa.

Katso: Laskimen emulaattorin työtilan käyttö luokkaesitysten parantamiseksi.



Ensimmäinen käynnistys: Emulaattorin tyypin valitseminen

Kun MathPrint™-laskimen TI-SmartView™-emulaattoriohjelmisto käynnistyy
ensimmäisen kerran tietokoneessasi, näkyviin tulee ilmoitusikkuna.

Valitse emulaattorin tyyppi pudotusvalikosta ja
paina OK-painiketta.
Valittu emulaattori näkyy ensimmäisessä
esityksessäsi.

MathPrint™-laskimen TI-SmartView™-emulaattoriohjelmisto käynnistyy aina tilassa,
jossa sitä on käytetty viimeksi. Avattuasi ohjelmiston voit vaihtaa oletusarvoista
emulaattoria.

Katso: Emulaattorin tyypin valitseminen.

Viimeisestä näkyvissä olevasta emulaattorin tyypistä tulee oletusarvo, ja
näkyviin tulee viimeksi käytetty ikkunan koko viimeisimpien asetustesi
mukaisesti.

Katso: TI-SmartView™-emulaattorin ison näyttöikkunan koon muuttaminen
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5 MathPrint™-laskimen TI-SmartView™-emulaattorin työalueen käyttö

MathPrint™-laskimen TI-SmartView™-emulaattorin
työalueen käyttö
MathPrint™-laskimen TI-SmartView™-emulaattorin työalue sisältää työkalut, joilla
syötetään laskutoimituksia.



TI-SmartView™-emulaattorin työalueen osat

Valikkorivi – Näiden valikoiden avulla voit suorittaa kaikki emulaattorin
toiminnot, esimerkiksi:

• File (tiedosto) – poistu tai
lopeta

• Actions (toiminnot) – esimerkiksi
näyttökuvan kaappaus

• Edit (muokkaa) –
esimerkiksi näppäimen
kopiointi fonttina

• Help (ohje) – ohjeet ja linkit

• View (näytä) – näyttöjen
vaihtaminen

Huomaa: Voit tehdä suurimman osan näiden valikoiden toiminnoista
napsauttamalla työkalurivin kuvakkeita.

Työkalurivi – Työkalurivin kuvakkeilla voit:
• Valita toisen laskinmallin
• Muuttaa näyttöä näyttämällä tai piilottamalla ison näyttöikkunan tai

näppäilyhistorian
• Kaapata emulaattorin näyttökuvan

Emulaattorin ja työkalurivin sijaintien valitseminen

• Emulaattorin sijainti vasemmalla/oikealla – vaihtaa tieteislaskimen
näyttöikkunan paikkaa vasemmalle tai oikealle puolelle. Tämä on kätevä
ominaisuus, kun kuva heijastetaan interaktiivisille valkokankaalle.

• Työkalurivi ylhäällä/alhaalla – vaihtaa työkalurivin näytön ylä- tai
alareunaan. Tämä on kätevä ominaisuus, kun kuva heijastetaan
interaktiivisille valkokankaalle.

Huomaa: Voit muuttaa elementtien visuaalista asettelua ja/tai paikkaa, jotta
näyttö on paras mahdollinen varsinkin interaktiivisen valkokankaan käytön
yhteydessä.

Emulaattorin ikkuna – Tässä ikkunassa voit näyttää koko emulaattorin tai vain
emulaattorin näppäimistön.

Iso näyttöikkuna / näppäilyhistorian ikkuna – Tässä ikkunassa voit näyttää
laskimen näytön isossa ikkunassa ja/tai näppäilyhistorian.
Näyttöikkunan vaihtoehdot:

• Vain iso näyttöikkuna • Vain näppäilyhistoria
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7 MathPrint™-laskimen TI-SmartView™-emulaattorin työalueen käyttö

• Iso näyttöikkuna +
näppäilyhistoria • Piilota iso näyttöikkuna

Muuta ikkunoiden kokoa – Voit muuttaa ikkunan kokoa napsauttamalla ja
vetämällä ikkunan vieressä olevaa pystypalkkia.

TI-SmartView™-emulaattorin näppäimistön käyttö
Hiiri toimii nyt ikään kuin tietokoneen näppäimistön näppäimiä painavina sormina.

Napsauta MathPrint™-laskimen TI-SmartView™-emulaattorin näppäimiä samalla tavalla
kuin painaisit tieteislaskimen näppäimiä.

Voit vierittää kohdistinta jatkuvasti pitämällä nuolinäppäintä painettuna.

Kun siirrät kohdistinta nuolinäppäimellä, voit vierittää kohdistinta jatkuvasti pitämällä
näppäintä painettuna sen sijaan, että painaisit näppäintä toistuvasti.
Näppäilyhistoriassa toistavan nuolinäppäimen merkkinä on näppäimeen kiinnitetty
kellon kuva.

Kun painat nuolinäppäintä useita kertoja rivillä, näkyviin tulee nuoli, jossa on laskuri.

Kun painat nuolinäppäintä useita kertoja rivillä, näppäilyhistoriassa näkyy yksi

nuolipainike. Tähän nuolinäppäimeen on kiinnitetty numero, joka ilmaisee, kuinka
monta kertaa nuolinäppäintä on painettu.

Näyttökuvan vetäminen ja pudottaminen toiseen sovellukseen
Voit vetää ja pudottaa sekä liittää minkä tahansa MathPrint™-laskimen TI-SmartView™-
emulaattorin näyttökuvan toiseen sovellukseen.

MathPrint™-laskimen TI-SmartView™-emulaattorin näyttökuvia, joita voit vetää ja
liittää, ovat seuraavat:

• Näyttö, joka on emulaattorin ikkunassa olevan näppäimistön yläpuolella

• Iso näyttöikkuna

• Näyttökuvan kaappauksen työalueella olevat tallennetut tai tallentamattomat
kaapatut näyttökuvat



Emulaattorin palauttaminen alkutilaan
Emulaattorin palautus alkutilaan:

1. Napsauta komentoa Actions (toiminnot).

2. Napsauta komentoa Reset Emulator (palauta emulaattori alkutilaan).

3. Napsauta Reset (palauta) -painiketta.

Emulaattorin palautus alkutilaan:

• Korvaa emulaattorin nykyisen tilan

• Tyhjentää näppäilyhistorian

MathPrint™-laskimen TI-SmartView™-emulaattorin työalueen käyttö 8



9 MathPrint™-laskimen TI-SmartView™-emulaattorin työalueen käyttö

MathPrint™-emulaattorin tallentaminen ja lataaminen Tila
Kun tallennat MathPrint™-emulaattorin tilan, sovellus luo tiedoston, johon tallentuvat
emulaattorin asetukset sekä kaikki tekemäsi muutokset.

Tästä on hyötyä, kun esimerkiksi haluat valmistella luokkaesityksen syöttämällä tietoja
dataeditoriin sekä funktioita syöttöriveille f(x) ja g(x). Kun tallennat muutokset
emulaattorin tilatiedostoon, voit näyttää esityksen helposti ainoastaan lataamalla
tiedoston. Jos haluat laatia erilaisia esityksiä eri luokille, voit luoda useita emulaattorin
tilatiedostoja.

Huomaa: Näppäilyhistoria, näytön kaappauskuvat, emulaattorin näkymä ja
emulaattorin koko eivät tallennu emulaattorin tilatiedostoon. Huomaa, että
MathPrint™-emulaattorin tilatiedostot voivat olla suuria. Jos tallennustilan kanssa on
ongelmia, ota yhteys laitoksen IT-tukihenkilöön.

MathPrint™-emulaattorin tilan tallentaminen

Emulaattorin tilatiedoston hallinta, tallennus ja lataaminen ovat mahdollisia kaikissa
MathPrint™-emulaattoreissa. TI-30X Plus MathPrint™ -emulaattorin tilatiedoston voi
ladata vain TI-30X Plus MathPrint™ -emulaattoriin.

Huomaa: TI-30X Pro MathPrint™ -emulaattorin tilatiedoston voi ladata vain TI-30X Pro
MathPrint™ -emulaattoriin.

1. Napsauta komentoja Actions (toiminnot) > Save Emulator State... (tallenna
emulaattorin tila...).

2. Valintaikkunassa:

a) Siirry kansioon, johon haluat tallentaa MathPrint™-emulaattorin tilatiedoston.
b) Kirjoita tiedostonimi. Valitse nimi, joka kuvaa MathPrint™-emulaattorin tilaa.



Huomaa:MathPrint™-emulaattorin tilatiedostoilla on valmiiksi määritetty
tiedostonimi, jonka tarkenne on *.s3l. Se ilmaisee, että TI-30X Plus MathPrint™
-laskimen emulaattorin tila on luotu TI-SmartView™ MathPrint™ -
emulaattoriohjelmistolla. TI-30X Pro MathPrint™ -laskimen emulaattorin tilan
tiedostotunniste on *.s3r.

c) Napsauta komentoa Save (tallenna).

MathPrint™-emulaattorin tilan lataaminen

Koska MathPrint™-emulaattorin tilatiedostot ovat laskinmallikohtaisia, voit ladata vain
aktiivisena olevan laskinmallin emulaattorin tilatiedoston.

1. Napsauta komentoja Actions (toiminnot) > Load Emulator State... (lataa emulaattorin
tila...).

2. Valintaikkunassa:

a) Siirry kansioon, joka sisältää emulaattorin tilatiedoston.

Huomaa: Näkyviin tulevat vain aktiivisena olevan laskinmallin MathPrint™-
emulaattorin tilatiedostot.

b) Korosta MathPrint™-emulaattorin tilan nimi napsauttamalla sitä.
c) Napsauta komentoa Open (avaa).
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11 MathPrint™-laskimen TI-SmartView™-emulaattorin työalueen käyttö

Näytön asetusten valitseminen
Voit mukauttaa näytön, siten että näytät tai piilotat lisäikkunat tai voit vaihtaa kussakin
ikkunassa näkyvien tietojen tyyppiä. Oletusarvoisesti MathPrint™-laskimen TI-
SmartView™-emulaattoriohjelmisto näyttää laskimen emulaattorin työalueen isossa
näyttöikkunassa.

Laskimen näyttöikkunan näyttö

1. Napsauttamalla

painiketta voit
piilottaa ison
näyttöikkunan.

2. Napsauttamalla uudelleen painiketta voit
näyttää ison näyttöikkunan.

Emulaattorin tyypin valitseminen

Valitse emulaattorin tyyppi napsauttamalla kuvakkeen nuoli alas -painiketta.

Jokainen emulaattorityyppi näyttää sille kuuluvan laskinmallin.



Laskimen kuoren vaihtaminen

Kuoren vaihtaminen:

1. Napsauta komentoa View (näytä).

2. Vie kohdistin Calculator Faceplate (laskimen kuori) -kohdan päälle.

3. Napsauta laskimen kuoren nimeä.

Vaalea Tumma Ääriviivat

Näppäilyhistorian näyttäminen tai piilottaminen

Napsauttamalla painiketta voit näyttää tai piilottaa näppäilyhistorian.
Voit tyhjentää historian napsauttamalla näppäilyhistorian vieressä olevassa ikkunassa
näkyvää CLEAR (tyhjennä) -painiketta.

Napsauta tässä ja
muuta
näppäilyhistorian
ikkunan kokoa
vetämällä.

Napsauta
tässä
valittuasi
näppäimet,
jotka
kopioidaan
kuvina.

Tyhjennä
näppäilyhistoria
napsauttamalla
tässä.
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13 MathPrint™-laskimen TI-SmartView™-emulaattorin työalueen käyttö

Kun painat tyhjennyspainiketta, näkyviin tulee alla oleva ikkuna:

Näppäilyhistorian kopioiminen toiseen sovellukseen
Voit kopioida koko näppäilyhistorian tai vain valitun osan siitä toiseen sovellukseen,

esimerkiksi tekstinkäsittelyohjelmaan. Voit kopioida näppäinten kuvat sellaisina
kuin ne näkyvät näppäilyhistorian ikkunassa tai voit kopioida näppäinten painallukset
fonttitekstimerkkeinä5U6.

Huomaa: Kun kopioit näppäimet fonttitekstimerkkeinä, merkeille käytetään TI-30X Pro
Key -fonttia. Vain ensisijaisten näppäinten fontit liitetään. Kakkostoimintojen
näppäinten fontteja ei liitetä kopiosta TI-SmartView™-emulaattorin fonttitoimintona.
Voit lisätä manuaalisesti kakkostoimintojen ominaisuuksia asennetun fontin avulla.
Tämä fontti asennetaan tietokoneeseesi automaattisesti asentaessasi MathPrint™-
laskimen TI- SmartView™-emulaattoriohjelmiston. Fontti sisältää kaikki TI-30X Plus -
näppäinten fontit TI-30X Pro -näppäinfonttien alasarjana.

Näppäinten kopioiminen kuvina tai fonttimerkkeinä

1. Valitse kopioitava näppäin tai näppäimet.
Voit valita näppäimet näppäilyhistorian ikkunasta jollakin seuraavista
menetelmistä:

Näppäin Menetelmä
– Yksi näppäin: Napsauta näppäintä.

– Useita näppäimiä: Napsauta näppäintä.
Pidä tietokoneen näppäimistön Ctrl-
näppäintä painettuna.
Valitse useita näppäimiä
napsauttamalla tarvittavia näppäimiä.

– Useita näppäimiä peräkkäin: Napsauta näppäintä.
Pidä tietokoneen näppäimistön Vaihto-
painiketta painettuna.
Paina toista näppäintä.
Huomaa: Tällä tavalla voit valita
kyseiset kaksi näppäintä plus kaikki
niiden välillä olevat näppäimet.



Näppäin Menetelmä
– Kaikki näppäimet: Napsauta näppäintä.

Napsauta hiiren oikeaa painiketta.
Napsauta komentoa Select All (valitse
kaikki).

Huomaa: Alla olevasta kuvasta näet, miltä näppäin näyttää ennen
valitsemista ja valitsemisen jälkeen.

Ennen: Jälkeen:

2. Valitse näppäimet.

3. Napsauta komentoa Edit (muokkaa) > Copy (kopioi) (kun haluat kopioida näppäimet
kuvina)

tai

Napsauta komentoa Edit (kopioi) > Copy As Font (kopioi fonttina) (kun haluat
kopioida näppäimet ensisijaiseksi fonttimerkiksi)5U6.

4. Vaihda toiseen sovellukseen.

5. Liitä näppäimet sopivaan kohtaan.

Huomaa:

• Voit myös vetää valitut näppäimet kuvina toiseen sovellukseen.

• Voit muuttaa näppäinkuvien kokoa liitettyäsi ne uuteen sovellukseen.

• Joissakin sovelluksissa fonttina liitetyt merkit voivat näkyä fontilla, joka on käytössä
liittämiskohdassa, jolloin ne eivät välttämättä ole lainkaan samannäköisiä kuin
tieteislaskimen näppäimet. Vaihda merkeille tarvittaessa TI-30X Pro Key -fontti.
Fonttien valitseminen merkeille on kuvattu käytössä olevan sovelluksen
ohjetiedostossa.
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15 MathPrint™-laskimen TI-SmartView™-emulaattorin työalueen käyttö

TI-SmartView™-emulaattorin ison näyttöikkunan koon
muuttaminen
Voit muuttaa kokoa napsauttamalla ja vetämällä ison näyttöikkunan reunaa.

Huomaa: Kaikkien muiden ikkunoiden kokoa muutetaan vetämällä vasemmalle/oikealle
paitsi näppäilyhistorian ikkunan, jonka kokoa muutetaan vetämällä reunaa ylöspäin tai
alaspäin.

Emulaattorin ja työkalurivin sijainnit
Emulaattorin sijainti vasemmalla/oikealla – vaihtaa tieteislaskimen
näyttöikkunan paikkaa vasemmalle tai oikealle puolelle. Tämä on kätevä
ominaisuus, kun kuva heijastetaan interaktiivisille valkokankaalle.

Työkalurivi ylhäällä/alhaalla – vaihtaa työkalurivin näytön ylä- tai
alareunaan. Tämä on kätevä ominaisuus, kun kuva heijastetaan
interaktiivisille valkokankaalle.



Always in Front (aina päällä)
Valitse tämä vaihtoehto View (näytä) -valikosta, jos haluat pitää MathPrint™-laskimen
TI-SmartView™-emulaattorin ikkunat aina muiden avoinna olevien tietokoneohjelmien
ikkunoiden päällä. Näin laskin on ikään kuin pöydälläsi papereiden päällä. Sijoita ikkuna
tietokoneen työpöydälle kohtaan, jossa se voi olla aina päällimmäisenä.

Voit poistaa Always in Front -valinnan View (näytä) -valikon vastaavasta kohdasta.
Työkalurivillä ei ole kuvaketta tälle toiminnolle eikä muuta merkkiä kuin valikossa
näkyvä käytössä olon valintamerkki.

Huomaa:

MathPrint™-laskimen TI-SmartView™-emulaattorin työalueen ikkuna ja näyttökuvan
kaappausikkuna ovat kumpikin aina päällimmäisinä ja vaihtavat tätä tilaa keskenään
sijaintinsa mukaan.

Always in Front -valinta ei ole suositeltava koko näytön tilassa, sillä tällöin muut ikkunat
ovat koko näytön peittävän MathPrint™-laskimen TI-SmartView™-emulaattorin takana.

MathPrint™-laskimen TI-SmartView™-emulaattorin työalueen käyttö 16



17 Näyttökuvan kaappauksen käyttö

Näyttökuvan kaappauksen käyttö
Voit kaapata tieteislaskimen näyttökuvia MathPrint™-laskimen TI-SmartView™-
emulaattorin näyttökuvien kaappauksella.

Näyttökuvan kaappauksen käyttö:

▶ Napsauta työkalurivin kuvaketta .

Näytölle avautuu alla näkyvä ikkuna:



Näyttökuvan kaappauksen työalueen osat

Capture
(kaappaa)

Napsauttamalla tässä voit kaapata emulaattorin näyttökuvan.
Actions (toiminnot) > Capture Screen (kaappaa näyttö)
Huomaa: Kun kaappaat kuvan, sen ympärille lisätään
automaattisesti kehys, mutta voit poistaa kehyksen
napsauttamalla komentoja View (näytä) > Hide Screen Capture
Borders (piilota näyttökuvan kehys). (Jos kuvia on useita,
kaikkien kuvien kehykset poistuvat.)
Näyttökuvien kaappauksella voit:
• kaapata enintään 44 näyttökuvaa kerrallaan (jos haluat

kaapata enemmän kuvia, poista kuvia Screen Capture
(näyttökuvien kaappaus) -ikkunasta.

• tallentaa näyttökuvat automaattisesti muistiin, jossa ne
säilyvät, kunnes suljet MathPrint™-laskimen TI-
SmartView™-pääikkunan.

Sulkiessasi kaappaustoiminnon ohjelma pyytää tallentamaan
näyttökuvat. Voit aloittaa uuden näyttökuvien kaappauksen
MathPrint™-laskimen TI-SmartView™-istunnon aikana.

Save (tallenna) Napsauttamalla tässä voit tallentaa valitut näyttökuvat.
File (tiedosto) > Save As (tallenna nimellä)

Copy (kopioi) Napsauttamalla tässä voit kopioida valitut näyttökuvat
leikepöydälle.
Edit (muokkaa ) > Copy (kopioi)

Delete (poista) Napsauttamalla tässä voit poistaa valitut näyttökuvat.
Edit (muokkaa) > Delete (poista)

Resize (muuta
kokoa)

Voit säätää näyttökuvan esikatselukokoa siirtämällä pistettä
palkkia pitkin.
View (näytä) > Scale Screen Captures (muuta näyttökuvien
kokoa)
Huomaa: Näyttökuvat tallentuvat näkyvissä olevan
prosenttiarvon mukaisina.

Rename (nimeä
uudelleen)

Voit nimetä näyttökuvan uudelleen korostamalla otsikon ja
kirjoittamalla uuden nimen.

View (näytä) Tässä voit katsella näyttökuvia.

Näyttökuvan vetäminen ja pudottaminen toiseen sovellukseen
Voit vetää ja pudottaa sekä liittää minkä tahansa MathPrint™-laskimen TI-SmartView™-
emulaattorin näyttökuvan toiseen sovellukseen.

MathPrint™-laskimen TI-SmartView™-emulaattorin näyttökuvia, joita voit vetää ja
liittää, ovat seuraavat:

• Näyttö, joka on emulaattorin ikkunassa olevan näppäimistön yläpuolella

• Iso näyttöikkuna

Näyttökuvan kaappauksen käyttö 18
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• Näyttökuvan kaappauksen työalueella olevat tallennetut tai tallentamattomat
kaapatut näyttökuvat



Tietokoneen näppäimistön käyttö emulaattorin
näppäinten sijasta
Voit käyttää tietokoneen näppäimistön näppäimiä TI-SmartView™-emulaattorin
näppäimistökuvan sijasta.

Tietokoneen näppäimistön käyttö
Kun painat emulaattorin näppäimiä tietokoneen näppäimistön kautta, käytä apuna alla
olevaa taulukkoa, johon on merkitty emulaattorin näppäimiä vastaavat näppäimet
tietokoneen näppäimistöllä.

• TI-30X Pro MathPrint™ or TI-30X Plus MathPrint™ näppäinyhdistelmillä

• TI-30XS-30XB MultiView™ näppäinyhdistelmillä

• TI-34 MultiView™ näppäinyhdistelmillä

Tietokoneen näppäimistön käyttö emulaattorin näppäinten sijasta 20
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TI-30X Pro MathPrint™ or TI-30X Plus MathPrint™

Esimerkki: Kun haluat näyttää tilaikkunan emulaattorissa, paina tietokoneen
näppäimistön näppäintä [W] alla olevan taulukon ohjeen mukaan.

TI-30X Pro MathPrint™ näppäinyhdistelmillä:

TI-30X Plus MathPrint™ näppäinyhdistelmillä:



*Huomaa:

MAC-tietokoneen näppäimistöllä:

- [Delete] korvaa näppäimenJ.
- [Askelpalautin] korvaa näppäimen-.

Tietokoneen näppäimistön käyttö emulaattorin näppäinten sijasta 22
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TI-30XS/30XB MultiView™

Esimerkki: Kun haluat näyttää tilaikkunan emulaattorissa, paina tietokoneen
näppäimistön näppäintä [W] alla olevan taulukon ohjeen mukaan.



*Huomaa:

MAC-tietokoneen näppäimistöllä:

- [Delete] korvaa näppäimenJ.
- [Askelpalautin] korvaa näppäimen-.

Tietokoneen näppäimistön käyttö emulaattorin näppäinten sijasta 24
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TI-34 MultiView™

Esimerkki: Kun haluat näyttää tilaikkunan emulaattorissa, paina tietokoneen
näppäimistön näppäintä [W] alla olevan taulukon ohjeen mukaan.



*Huomaa:

MAC-tietokoneen näppäimistöllä:

- [Delete] korvaa näppäimenJ.
- [Askelpalautin] korvaa näppäimen-.

Tietokoneen näppäimistön käyttö emulaattorin näppäinten sijasta 26



27 Yleistä

Yleistä
Online-tuki
education.ti.com/eguide

Valitse maasi, niin näet lisää tuotetietoja.

Ota yhteyttä TI-tukeen
education.ti.com/ti-cares

Valitse maasi, niin näet teknisiä tietoja ja muita tukiresursseja.

Huolto- ja takuutiedot
education.ti.com/warranty

Valitse maasi, niin saat tietoa takuun kestosta ja ehdoista tai tuotepalvelusta.

Rajoitettu takuu. Tämä takuu ei vaikuta lainmukaisiin oikeuksiisi.

https://education.ti.com/eguide
https://education.ti.com/ti-cares
https://education.ti.com/warranty
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